
Introduction

SnapShot 3 is an easy-to-use screen capture utility that uses a camera metaphor. Once you 
have loaded the "Film," you can take snapshots of the screen using your right mouse button. 
"Film" can be loaded from the File menu or the Toolbar. Snapshots can be placed into the 
Clipboard for pasting into other applications, printed or saved in a number of graphics formats.
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What is new with Version 1.3



Commands

There are four menus in SnapShot 3

File
Edit
View
Help

Note: You can quickly jump to this page by clicking on the Commands button.
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File Menu Commands

The File menu contains the following commands:

New
Open
Save As...
Print
Printer Setup...
Developer...
Auto Save...
Options
Load Film
UnLoad Film
Exit
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File/New

New clears the current picture.



File/Open

Open... displays the Open dialog box. This dialog box allows you to select a bitmap file and load
it into SnapShot 3.

You can enter the filename directly or you can search for it using the list boxes and combo 
boxes.

When you have the correct file in the File Name: edit box, click OK    to load the file into 
SnapShot 3.

You can read the following formats:

BMP Windows bitmaps
GIF CompuServe graphics interchange file format
ICO Windows icons
JPG JPEG (Joint Photographic Experts Group)
PCX Zsoft PCX format
PCD Photo CD files
PCT Apple Pict files
TGA Targa file format
TIF TIFF (Tagged Image File Format) files
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File/Save As...

Save As... displays the Save As dialog box where you can save the current picture to a file.

The bottom row of radio buttons allow you to save the picture to a different format. The choices 
available allow for changes in color content, compression, and size.

Option Description

1 bpp Black and white picture
4 bpp 16 colors
8 bpp 256 colors
24 bpp 24 BPP

RLE4 Run length encoded 16 Color
RLE8 Run length encoded 256 Color
BMP BMP format

Original Original size
Stretched Stretched to current client size
Full Screen Stretched to full screen size

When you first open the Save As dialog the current settings will reflect the current condition for 
the picture.

Click OK to save the picture according to your settings.

Please note that the center section is only valid for BMP file types. The following chart shows 
the support file types and bit-per-pixel settings (bpp).

Type 1 bpp 4 bpp 8 bpp 24 bpp
BMP X X X X
GIF X X
JPG X X
PCX X X X X
PCT X X X X
TGA X X
TIF X X X X
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File/Print

Print lets you print the current picture on your installed printer.

The picture can be printed in a variety of sizes. These sizes include:

Option Description

Original Original Picture Size
Stretch to Client Size Stretch picture to size of SnapShot 3's client area
Stretch to Full Screen Size Stretch picture to size of screen
Stretched to Page Stretch to full page size

These options are set via the Options dialog accessable from the File menu.
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File/Printer Setup...

Printer setup... lets you change the setup for your currently installed printer. You'll see the 
standard Windows printer Setup dialog box. See your Microsoft Windows documentation for 
information concerning this dialog box.

Any changes you make are only for your session with SnapShot 3. If you desire to change the 
printer settings for other applications you can do so through the Windows Control Panel.
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File/Developer

Displays the Developer dialog. With the Developer dialog you can quickly preview bitmap files. 
Developer's listbox lets you search for bitmap files quickly. Double-click on a file to have 
SnapShot 3 open it. You can traverse directories or drives by double-clicking on those items in 
Developer's listbox.

The Developer dialog is modeless, so it stays on top of SnapShot 3 thereby letting you quickly 
preview a number of bitmaps without repeatedly selecting File/Open and researching
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File/Auto Save...

Prompts you for an initial filename and type using the Save As... dialog. Each subsequent 
screen capture will be saved to this filename with an increasing count appended to the name. 

For example, you select TEST.BMP. Your first screen capture will be saved to TEST00.BMP. 
The next to TEST01.BMP and so on.

To turn off Auto Save select Cancel from the dialog box.
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File/Options...

Options... displays the SnapShot 3 Options dialog box where you can modify snapshot 3's 
behavior. Click on an option or button to see more information.
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Clipboard Options

The Clipboard Options dialog determines if and how SnapShot 3 converts an image before 
placing it in the Clipboard.

Click on an option or button to see more information.
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Monochrome

The image is converted to black and white before being placed in the Clipboard



Color

The image is placed unconverted in the Clipboard.



Original

The image is placed in the Clipboard without any changes to it's size



Stretched

The image is stretched to the current client size of SnapShot 3 before being placed in the 
Clipboard.



Full Screen

The image is stretched to full screen size before being placed in the Clipboard.



Printing Options

Click on an option or button to see more information.
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Keyboard Options

Allows you to enable capture with the keyboard. If the checkbox is selected then that option is 
enabled.

To capture the Active window use the keyboard combination of Ctrl + Alt + A

To capture the entire desktop use the keyboard combination of Ctrl + Alt + D 



Original Size

Prints the image at it's original size



Stretch To Client Size

Prints the image stretchedto the size of SnapShot 3's client area



Stretch To Full Screen Size

Prints the image stretched to the size of the screen



Stretch To Page

Prints the image stretched to the size of an entire page.



File/Load Film

Load Film enables the right mouse button as your shutter for SnapShot 3.

Film can be loaded using this menu command or from the Control menu bar (you'll use the 
Control menu bar option to load film when you have minized SnapShot 3 ). 

Film can be automatically loaded by selecting Automatically Load Film When Starting using 
the File/Options... command.
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File/Unload Film

Unload Film disables the right mouse button so that you can no longer take pictures.

Film can be unloaded using this menu command or from the Control menu bar 
(you'll use the Control menu bar option to unload film when you have minimized 
SnapShot 3.)
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File/Exit

Exit terminates SnapShot 3.



Edit Menu Commands

The Edit menu contains the following commands.

Copy
Paste
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Edit/Copy

Copy copies the contents of SnapShot 3 to the Windows Clipboard. Once the file is in the 
Clipboard, you can paste it into other Windows applications.



Edit/Paste

Paste inserts the contents of the Windows Clipboard into SnapShot 3. Clipboard contents must 
be in a bitmap format. Other formats are not supported and are ignored



 View Menu Commands

The View menu contains the following commands:

Stretch
Full Screen
Toolbar
Status Line
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View/Stretch

Toggles the stretch mode between Original and Stretched.

Original draws the picture in its originally captured size.

Stretched stretches the picture to fill the current size of SnapShot 3. If you resize SnapShot 3 
this stretching is repeated. You can save the picture at a stretched size using the format option 
Current in the Save As dialog.

When in stretched mode this menu item will have a checkmark next to it.
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View/Full Screen

Full Screen blanks the entire screen and displays the current picture. If the stretch 
mode is set then the image is stretched to fill the entire screen. If the stretch mode 
is set to original then the image is displayed at the center of the screen.

When you are finished viewing, hit any key or click a mouse button to restore 
SnapShot 3. 
You can save the picture at the size of the screen using the format option Full 
Screen in the Save As dialog box.
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View/Toolbar

Allows you to select whether the toolbar is visible. When selected this item will have a 
checkmark next to it and the toolbar will be displayed just below the menu bar. 

Click on the toolbar bitmap for more information.
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View/Status Line

Allows you to select whether the Status Line is visible. When selected this item will have a 
checkmark next to it and the Status Line will be displayed at the bottom of SnapShot 3's 
window.

Click on the status line bitmap for more information.
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Status Line Filename

Displays the current filename. If the images was just captured an not yet saved then this field 
will display <<Capture>>. If the images was just pasted into SnapShot 3 and has not been 
saved then this field will display <<Clipboard>>.

If you double-click on this region of the status line the File Open dialog is displayed allowing you
to select a new file to view.
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Status Line Film

Displays the Film status, either Loaded or Un-Loaded. 

If you double-click on this region of the status line you will toggle the Film status. If Film is 
Loaded then double-clicking will un-load the film. If Film is not currently loaded then it will be 
loaded.
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Status Line Stretched / Actual

Displays the view mode status. Either Actual or Stretched.

If you double click on this region of the status line you will toggle the view mode status. If you 
are viewing in Actual size mode the view will change to the Stretched mode. If you are currently 
viewing in Stretched mode, double clicking will change the view mode to Actual.
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Status Line Size
Displays the current image size.

Double clicking on this area when in stretch mode will present the Size dialog. This dialog 
allows you to precisely change the size of the current image.
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Size Dialog

The Size dialog lets precisely change the size of the current image. Resizing changes effect the 
internal copy of the image. Save the image before resizing so you can reload the image if you 
do not like the result of resizing. 

Important:
If you are in stretch mode you will not see the Size dialog after double clicking on the 
size area of the status line. You can only size the image if it is being displayed as actual 
size.

To use the Size dialog you enter the new Width and Height of the image in the areas provided. 
Select Ok to have SnapShot 3 resize the image. If you select the Warn before resizing you will 
receive a Warning box letting you change your mind after selecting Ok. 

Important:
Resizing can result in a distored image. If you shrink an image some information will be 
removed to squeeze the image to it's new size. If you resize back to a large image it will 
not look the same. You may consider saving a copy of the image before you experiment 
with resizing so you can easily start over.



Status Line AutoSave
Displays whether Auto Save is enabled or not.

If you double click on this region the Auto Save dialog is presented just as when you select the 
File Auto Save menu pick.

See...
Status Line



Help Menu Commands

The Help menu contains the following commands:

Index
Commands
Procedures
About SnapShot 3...
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Help/Index

Index opens this help file at the Introduction page. This page can also be reached by pressing 
the Contents button of the Help Window menu.



Help/Commands

Commands opens this help file at the Menu Commands page.



Help/Procedures

Procedures opens this help file at the Procedures page. This page can also be reached by 
pressing the Procedures button of the Help Window menu.



Help/About SnapShot 3...

About SnapShot 3... opens the About box describing SnapShot 3, Beacon Hill Software and 
other information about SnapShot 3



 Procedures

SnapShot 3 is easy to use. Once the film is loaded (activating your right mouse 
button), you can capture screen images and paste them into other Windows 
applications or save them. You can stretch the picture to fit the size of the client 
area of the SnapShot 3 window. By tiling SnapShot 3 and other Windows 
applications, you can quickly capture images, enhance them, save them and then 
use them in other applications.

Note: You can quickly jump to this page by clicking on the Procedures button.

Taking Pictures
Viewing Pictures
Saving Pictures
Stretching Pictures
Pasting from the Clipboard
Erasing Pictures
Viewing Saved Pictures
Setting Options
Drag and Drop
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Taking Pictures

Taking pictures using SnapShot 3 is simple. To take a picture of the screen you must first enable
the shutter. The right mouse button is your shutter.

-    Load film by choosing File/Load Film (unless it was automatically loaded).

- To capture an entire window, click the right mouse button on the Window Title Bar. Your pointer
is not included in the picture.

- To capture a section of the screen, you'll click-and-drag using your right mouse button. Position
your pointer at the upper left corner of the rectangular area you want to capture. Click-hold-and-
drag the right button to the lower right corner of the area you want to capture. You'll see an 
outline of the area you are about to capture as you drag your mouse. When you release the 
right mouse button, the outlined area is captured. You have taken a picture.

- The captured picture may automatically be placed into the Clipboard, depending on your 
Options dialog box settings.
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Viewing Pictures

Pictures can be viewed in different ways. Stretch keeps the client area of SnapShot 
3 filled with the picture by stretching it whenever the window is resized. Full Screen 
stretches the picture to fill the entire screen. 

Also, you can load bitmaps and cut-and-paste between SnapShot 3 and the 
Clipboard to view bitmaps.

When the picture is the way you want it, you can save it in a number of graphics 
formats.
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Saving Pictures

 If you wish to save a screen capture, pasted in picture or to another file select 
File/Save As... 

For more info click here.
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Stretching Pictures

To stretch the current picture to fit the client size of the SnapShot 3 window, select 
View/Stretch.

If you change the size of the SnapShot 3 window, the picture will automatically 
change to fit the window.
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Pasting from the Clipboard

To paste a bitmap from the Clipboard, select Edit/Paste. The bitmap will be displayed in the 
SnapShot 3 window.
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Erasing Pictures

To erase the current bitmap, select File/New.
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Viewing Saved Pictures

To view a previously-saved bitmap file, select File/Open... and choose the file you want to load 
into SnapShot 3.

You can also view previously-saved files using the File Manager and SnapShot 3. You'll need to 
change the association of bitmaps    to SnapShot 3 with the File Manager's File/Associate menu 
selection (don't worry, it's easy). Changing the File Manager association to SnapShot 3 will let 
you easily view many bitmaps.

Arrange the File Manager and SnapShot 3 so they are both visible on the screen. You can 
easily browse through sub-directories of BMP files and view them with just a double-click of the 
mouse.

For more information click here.
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Setting Options

You can setup SnapShot 3 to automatically perform certain operations - saving you the time and
making SnapShot 3 easier to use.

Select File/Options... to display the SnapShot 3 Options dialog box where you can modify 
SnapShot 3's behavior.

For more information click here
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Drag and Drop

SnapShot 3 support Drag and Drop from the File Manager in Windows 3.1. You can select a 
bitmap file from the File Manager and drag and drop it on SnapShot 3 and SnapShot 3 will open
it. If you select a group of files at one time and drop them on SnapShot 3 only the last one in the
list will be opened.
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Tips

Help, I cannot take a picture!
How do I capture the entire screen?
Why is only a portion of a window captured?
How do I select only a portion of a window or screen?
How do I save a picture I have captured?
How do I save a picture as a monochrome bitmap?
After I have stretched a bitmap, how do I save it at this size?
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Help, I cannot take a picture!

Make sure you have loaded film. To load film, select File/Load Film.



How do I capture the entire screen?

If you want to capture the entire screen, and the screen is one window, click on the Title Bar.

If you want to capture the entire screen, and it is composed of many windows, click on an area 
of the screen that is not occupied by a window. You may have to move the windows a bit to 
make a small space.



Why is only a portion of a window captured?

If you are having problems capturing the entire window, click on the Title Bar with the right 
mouse button.

If you are manually capturing a window, make sure the window in fully exposed. SnapShot 3 will
take a picture of anything partially covering a window.



How do I select only a portion of a window or screen?

You'll use the click-and-drag technique with your right mouse button to capture 
portions of the screen or window.

Press down on the right button when the cursor is in the upper left corner of the 
rectangular region you wish to select. While holding the button down, drag the 
mouse to the lower right corner. The area you are about to capture is outlined. 
When you are at the lower right corner release the button. The area will then be 
captured. You have taken a picture.



How do I save a picture I have captured?

If you have a picture you want to save, do the following:

1) Select File/Save As... to display the Save As... dialog box
2) Choose a radio button for the file type you want
3) Click the Original radio button
4) Select a destination path
5) Type a file name
6) Click OK

The file will be saved as indicated.



How do I save a picture as a monochrome bitmap?

If you have a picture you want to save as a monochrome (black and white) BMP file, do the 
following:

1) Select File/Save As... to display the Save As... dialog box
2) Click the Monochrome radio button
3) Click the Current radio button
4) Select a destination path
5) Type a file name
6) Click OK

The file will be saved as a monochrome bitmap.



After I have stretched a bitmap, how do I save it at this size?

If you have stretched a picture and you want to save it, do the following:

1) Select File/Save As... to display the Save As... dialog box
2) Select a file type
3) Click the Current radio button
4) Select a destination path
5) Type a file name
6) Click OK

This will save the bitmap at its current size.



 Using Dynamic Data Exchange

You can use Dynamic Data Exchange (DDE) to access SnapShot 3 from other applications. 

Basic Steps for Using DDE
Opening a Channel
Requesting Information
Advise Transactions
Executing Commands
Closing a Channel
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Basic Steps for Using DDE

All DDE conversations take place on a channel between two applications. The application that 
initiates a conversation is the client, the other application is the server. The client controls the 
channel and requests information from the server. SnapShot 3 can only act as a server. 

The basic steps required to use DDE with SnapShot 3 are:

1. Open a channel to SnapShot 3 from another application.

2. Request data, set up an advise loop or execute a SnapShot 3 command.

3. Close the channel.

The exact syntax of the commands used for DDE depend on the macro or programming 
language of the client application that you are using. Typically, establishing a channel is 
accomplised by an INITIATE command, requesting data by a REQUEST, setting up an advise 
transaction with an ADVISE, executing a command by EXECUTE, and closing a channel by a 
TERMINATE. These terms will be used throughout the rest of this topic. You should consult the 
documentation for your application for more specific details on these types of commands.
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Opening a Channel

To begin a DDE conversation, you must first open a channel between your application and 
SnapShot 3 using an INITIATE function.

Channel = INITIATE( application, topic )

To communicate with SnapShot 3, the application parameter must be "SNPSHOT3".
SnapShot 3 supports only one topic, "SYSTEM".

Channel = INITIATE( "SNPSHOT3", "SYSTEM" )

The result of the INITIATE command is a channel number. This value is used as a parameter in 
all subsequent DDE functions. If SnapShot 3 is not running or the topic is invalid, an error is 
returned.
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Requesting Information

Once a channel has been established, you can retrieve information from SnapShot 3 using the 
REQUEST function:

REQUEST( channel, item )

SnapShot 3 supports the following item specifications:

Item Returns

BITMAP Current Screen capture in Windows BITMAP format

For example,

REQUEST( channel, "BITMAP" )

Note: The bitmap returned will be in the format specified by the Clipboard Options setting. To 
set this option via DDE see File.SetOption.Clipboard
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Advise Transactions

You can use advise transactions to receive the current image whenever it is updated. For 
example, whenever a screen capture is taken a copy of the image will be sent via DDE to the 
client which has requested an advise transaction.

To request an advise transaction use the ADVISE function:

ADVISE( channel, item )

SnapShot 3 supports the following item specifications:

Item Returns

BITMAP Current Screen capture in Windows BITMAP format

For example,

ADVISE( channel, "BITMAP" )

Whenever the image in SnapShot 3 is updated a copy in Windows BITMAP format will be sent 
over the channel to the client application.

Note: The bitmap returned will be in the format specified by the Clipboard Options setting. To 
set this option via DDE see File.SetOption.Clipboard
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Executing Commands

The EXECUTE function is used to pass commands to SnapShot 3 through DDE.

EXECUTE( channel, [command_string] )

The command_string parameter consists of one of the following commands enclosed in square 
braces:

(Note: the sqaure braces are optional). 

Important! Only one command can be passed to SnapShot 3 at a time. To execute multiple 
commands use multiple EXECUTE commands.

Commands: Description:

File.New() Clears image in SnapShot 3, Erase
File.Open( filename ) Opens a BMP file.
File.SaveAs( filename, [bpp,type,size]) Saves a screen capture to a BMP file.
File.Print() Prints the current screen capture
File.PrinterSetup() Displays Printer Setup dialog
File.Developer() Displays Developer Dialog
File.AutoSave(filename,[bpp,type,size]) Sets AutoSave to On, initializes first 

filename
File.LoadFilm(0/1) Loads film if parameter is 1
File.UnLoadFilm Unloads film
File.Exit() Exits (closes) SnapShot 3
File.SetOption.AutoLoad(1/0) Sets up SnapShot 3 to automatically load 

film when starting
File.SetOption.AutoRestore(1/0) Sets up SnapShot 3 to restore (show 

itself) after a screen capture.
File.SetOption.Stretch(1/0) Sets up SnapShot 3 in stretch mode. 

Screen captures will be stretched to fit 
within SnapShot 3's client area

File.SetOption.AutoCopy(1/0) Sets up SnapShot 3 to automatically 
place a copy of each screen capture in 
the Clipboard.

File.SetOption.AutoHide(1/0) Sets up SnapShot 3 to hide itself during 
each screen capture.

File.SetOption.AutoPrint(1/0) Sets SnapShot 3 to print each capture 
after it has been taken.

File.SetOption.CaptureClientOnly(1/0)OR
File.SetOption.Client(1/0)

Sets up SnapShot 3 capture only the 
client area of a Window it is capturing.

File.SetOption.SaveWarning(1/0) Sets up SnapShot 3 to warn if an action is
going to erase the current image if it has 
not been saved.

File.SetOption.IgnoreClient(1/0) Sets up SnapShot 3 to ignore right button 
presses in the client area of applications.

File.SetOption.RaisedStatus(1/0) Sets up the Status Line orientation, either 
raised or depressed.



File.SetOption.Clipboard(value) Sets up SnapShot 3's clipboard options.
File.SetOption.Printing(value) Sets up SnapShot 3's printing options
Edit.Copy() Copies the current image to the clipboard.
Edit.Paste() Pastes the current image from the 

Clipboard into SnapShot 3.
View.Stretch(1/0) Sets the current stretch mode.
View.FullScreen(1/0) Displays the current image Full screen.
View.ToolBar(1/0) Show or hide ToolBar
View.StatusLine(1/0) Show or hide Status Line
Help.Index() Displays this help file.
Help.Commands() Displays this help file at the Commands 

page.
Help.Procedures() Displays this help file at the Procedures 

page.
Help.About() Displays SnapShot 3's About Box.
Window.Maximize() Maximizes SnapShot 3.
Window.Minimize() Minimizes SnapShot 3.
Window.Restore() Restores SnapShot 3.
Window.Move() Moves SnapShot 3.
Window.Size() Sizes SnapShot 3.
Window.Hide(1/0) Hides (and un-hides) SnapShot 3.
Capture.Window(hwnd) Captures a specific window.
Capture.ActiveWindow() Captures the currently active window.
Capture.Desktop() Captures the entire desktop.
Capture.Region(X0,Y0,X1,Y1) Captures a specific region.
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Closing a Channel

To close the channel, use the TERMINATE command.

TERMINATE( channel )
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File.New

Clears the current picture.

Syntax:

File.New()

Note: If you have the option Warn If Picture Needs Saving set. File.New will return FALSE if 
there is an image in SnapShot 3 that needs to be saved. You can turn off this option via DDE 
with the command File.SetOption.SaveWarning
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File.Open

Opens a bitmap file.

Syntax:

File.Open( filename )

Where filename is a valid bitmap filename.

Note: If you have the option Warn If Picture Needs Saving set. File.Open will return FALSE if 
there is an image in SnapShot 3 that needs to be saved. You can turn off this option via DDE 
with the command File.SetOption.SaveWarning
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File.SaveAs

Syntax

File.SaveAs( filename [ ,bpp,type,size ] )

Where filename is the name of the file you wish to save the current capture to.

The optional parameters bpp, type and size refer to values to modify the image before it
is saved. bpp determines the color content, type determines the file format and size 
determines the size of the image. The following is a table of values for each of these 
parameters.

Bpp Value Description
0 Monochrome
1 16 Colors
2 256 Colors
3 24 BPP

Type
0 RLE 4
1 RLE 8
2 BMP

Size
0 Current
1 Stretched
2 Full Screen

For additional information on these parameters and their means refer to the File Save As
dialog.

NOTE: The brakets [ and ] are for notating that the enclosed are optional parameters. 
they are not part of the command string.
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File.Print

Prints the current image.

Syntax:

File.Print()
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File.PrinterSetup

Displays the Printer Setup dialog box.

Syntax:

File.PrinterSetup()
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File.Developer

Displays the Developer dialog box.

Syntax:

File.Developer()
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File.AutoSave

Sets the intial filename for SnapShot 3's auto save functionality. Each subsequent screen 
capture will be saved to this filename with an increasing count appended to the name.

Syntax:

File.AutoSave( filename [ ,bpp, type, size ] )

Where filename is the name of the file you wish to auto save to.

The optional parameters bpp, type and size refer to values to modify the image before it
is saved. bpp determines the color content, type determines the file format and size 
determines the size of the image. The following is a table of values for each of these 
parameters.

Bpp Value Description
0 Monochrome
1 16 Colors
2 256 Colors
3 24 BPP

Type
0 RLE 4
1 RLE 8
2 BMP

Size
0 Current
1 Stretched
2 Full Screen

For additional information on these parameters and their means refer to the File Save As
dialog.

To turn off Auto Save send the File.AutoSave command with no parameters:

For example:

File.AutoSave( )

NOTE: The brakets [ and ] are for notating that the enclosed are optional parameters. 
they are not part of the command string.
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File.LoadFilm

Enables the right mouse button as your shutter for SnapShot 3.

Syntax:

File.LoadFilm()
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File.UnLoadFilm

Disables the right mouse button so that you can no longer take pictures.

Syntax:

File.UnLoadFilm()
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File.Exit

Terminates SnapShot 3

Syntax:

File.Exit()
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File.SetOption.AutoLoad

Sets the Automatically Load Film When Starting option. Film will be automatically loaded by 
SnapShot 3 each time it is run.

Syntax:

File.SetOption.AutoLoad( 1/0 )

Where 1 sets the option and 0 resets the option.

See...
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File.SetOption.AutoRestore

Sets the Automatically Restore After Capture option so SnapShot 3 automatically restores 
(show itself) after each screen capture.

Syntax:

File.SetOption.AutoRestore( 1/0 )

Where 1 sets the option and 0 resets the option.

See...
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File.SetOption.Stretch

Sets the Automatically Stretch Picture In View option. Each time SnapShot 3 is run it will 
automatically place itself in stretched view mode.

Syntax:

File.SetOption.Stretch( 1/0 )

Where 1 sets the option and 0 resets the option.

See...
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File.SetOption.AutoCopy

Sets the Automatically Put Picture in Clipboard option. Screen captures will be automatically 
placed in the Clipboard.

Syntax:

File.SetOption.AutoCopy( 1/0 )

Where 1 sets the option and 0 resets the option.

See...
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File.SetOption.AutoHide

Sets the Automatically Hide During Capture option. When this option is set, SnapShot 3 will hide
itself during a screen capture.

Syntax:

File.SetOption.AutoHide( 1/0 )

Where 1 sets the option and 0 resets the option.

See...
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File.SetOption.AutoPrint

Sets the Automatically Printer After Capture option. When this option is set SnapShot 3 will 
automactically print after each capture is performed.

Syntax:

File.SetOption.AutoPrint( 1/0 )

Where 1 sets the option and 0 resets the option.

See...
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File.SetOption.CaptureClientOnly File.SetOption.Client

Sets the Captures Of Client Only option. Screen captures of Windows will only be of there 
client area.

Syntax:

File.SetOption.CaptureClientOnly( 1/0 ) 
or
File.SetOption.Client( 1/0 )

Where 1 sets the option and 0 resets the option.

See...
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File.SetOption.SaveWarning

Sets the Warn If Picture Needs Saving option. When this option is set SnapShot 3 will prompt 
you to save the current image if it has not been saved and you are attempting an operation that 
will erase it, such as pasting in an image, opening a file or capturing another image.

Syntax:

File.SetOption.SaveWarning( 1/0 )

Where 1 sets the option and 0 resets the option.

See...
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File.SetOption.IgnoreClient

Sets the Ignore Right Button In Client Areas option. When set SnapShot 3 will ignore a Right 
Button click in a window's client area. This reduces interference with applications that use the 
right mouse button. If you wish to capture a portion of such a window's client area capture the 
entire window and then capture the portion you need from the screen capture taken by 
SnapShot 3.

Syntax:

File.SetOption.IgnorecClient( 1/0 )

Where 1 sets the option and 0 resets the option.

See...
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File.SetOption.RaisedStatus

Sets the Raised Status option. When set SnapShot 3 will draw the Status Line with a raised 
look rather than a depressed look.

Syntax:

File.SetOption.RaisedStatus( 1/0 )

Where 1 sets the option and 0 resets the option.

See...
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File.SetOption.Clipboard

Sets the Clipboard copy options. With these options you can have SnapShot 3 modify an image 
before placing it in the clipboard.

Syntax:

File.SetOption.Clipboard( 0/1, 0/1/2 )

Where the first option sets color of 0 for monochrome, 1 for color.
The second option sets size, 0 for original, 1 for stretched and 2 for full screen.

See...
Executing Commands



File.SetOption.Printing

Sets the Printing options. With these options you can have SnapShot 3 print images at different 
sizes.

Syntax:

File.SetOption.Printing( 0/1/2/3 )

Where 
0 original size
1 stretched size
2 full screen size
3 stretched to paper size

See...
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Edit.Copy

Copies the current image to the Windows Clipboard.

Syntax:

Edit.Copy()

See...
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Edit.Paste

Pastes the current contents of the Windows Clipboard into SnapShot 3. If the contents of the 
clipboard is not a bitmap then no action is taken.

Syntax:

Edit.Paste()

Note: If you have the option Warn If Picture Needs Saving set. Edit.Paste will return FALSE if 
there is an image in SnapShot 3 that needs to be saved. You can turn off this option via DDE 
with the command File.SetOption.SaveWarning

See...
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View.Stretch

Sets the view mode to stretched mode. When set images are stretched to fill SnapShot 3's 
client area.

Syntax:

View.Stretch( 0/1 )

Where 0 resets to original and 1 sets the view mode to stretched.

See...
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View.FullScreen

Sets the view mode to full screen. If the stretch mode is set then the image is displayed 
stretched to the size of the screen. If the stretch mode is not set then the screen is blanked and 
the image is displayed at the center of the screen.

When set images are displayed full screen until the user clicks the mouse, taps the keyboard or 
is reset by sending this command with a 0 parameter.

Syntax:

View.FullScreen( 0/1 )

Where 0 resets to original and 1 sets the view mode to full screen.

See...
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View.ToolBar

Sets whether the ToolBar is displayed.

Syntax:

ViewToolBar( 0/1 )

Where 0 hides the ToolBar and 1 displays it.

See...
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View.StatusLine

Sets whether the ToolBar is displayed.

Syntax:

View.StatusLine( 0/1 )

Where 0 hides the Status Line and 1 displays it.

See...
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Help.Index

Opens this help file at the Introduction page.

Snytax:

Help.Index()

See...
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Help.Commands

Opens this help file at the Menu Commands page.

Syntax:

Help.Commands()

See...
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Help.Procedures

Opens this help file at the Procedures page.

Syntax:

Help.Procedures()

See...
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Help.About

Displays SnapShot 3's About Box.

Syntax:

Help.About()

See...
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Window.Maximize

Maximizes SnapShot 3.

Syntax:

Window.Maximize()

See...
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Window.Minimize

Minimizes SnapShot 3

Syntax:

Window.Minimize()

See...
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Window.Restore

Restores SnapShot 3

Syntax:

Window.Restore()

See...
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Window.Move

Moves SnapShot 3.

Syntax:

Window.Move( X, Y )

Where X and Y are the screen coordinates you wish to move SnapShot 3 to.
See...
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Window.Size

Changes the size of SnapShot 3's window.

Syntax:

Window.Size( X, Y )

Where X is the desired new width and Y the desired new height.

Note: This command will return FALSE if SnapShot 3 is iconized.

See...
Executing Commands



Window.Hide

Hides SnapShot 3.

Syntax

Window.Hide( 0/1 )

Where 1 hides SnapShot 3 and 0 un-hides.

See...
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Capture.Window

Performs a screen capture of the Window whose handle you pass in as the first parameter.

Syntax:

Capture.Window( hWnd )

Where hWnd is the handle of the window you wish to capture. The value for    hWnd 
must be in hex format 0x0000.

See...
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Capture.ActiveWindow

Performs a screen capture of the currently active Window.

Syntax:

Capture.ActiveWindow()

Note: If you have the option Warn If Picture Needs Saving set. Capture.ActiveWindow will 
return FALSE if there is an image in SnapShot 3 that needs to be saved. You can turn off this 
option via DDE with the command File.SetOption.SaveWarning

See...
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Capture.Desktop

Performs a screen capture of the entire desktop.

Syntax:

Capture.Desktop()

Note: If you have the option Warn If Picture Needs Saving set. Capture.Desktop will return 
FALSE if there is an image in SnapShot 3 that needs to be saved. You can turn off this option 
via DDE with the command File.SetOption.SaveWarning

See...
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Capture.Region

Performs a screen capture of the region defined by the parameters passed with this command.

Syntax:

Capture.Region( X0, Y0, X1, Y1 )

Where the parameters define the rectangular region to capture. X0,Y0 is the upper left of
the rectangle and X1,Y1 is the lower right.

Note: If you have the option Warn If Picture Needs Saving set. Capture.Region will return 
FALSE if there is an image in SnapShot 3 that needs to be saved. You can turn off this option 
via DDE with the command File.SetOption.SaveWarning

See...
Executing Commands



Filename: 
Edit box for entering filenames or wildcard characters. The file that will be opened with by the 
dialog will be the one entered here. Searching with the listboxes below put filenames into this 
edit box.



Pathname:
The current pathname is show here.



Files Listbox
Listbox that displays the files in the curent directory.



Directories Listbox
Listbox that displays the current subdirectories.



Ok 
Opens the file selected in the Filename command window.



Cancel 
Closes the open dialog aborting the open procedure



List Files of Type
Select type of file.



Drives
Select current drive.



Filename: 
Edit box for entering filenames or wildcard characters. The file that will be saved with by the 
dialog will be the one entered here. Searching with the listboxes below put filenames into this 
edit box.



Pathname:
The current pathname is show here.



Files Listbox
Listbox that displays the files in the curent directory.



Directories Listbox
Listbox that displays the current subdirectories.



Ok 
Saves the current picture to the currently selected filename.



Cancel 
Closes the save dialog and aborts the save procedure.



BPP
Bits per pixel. Determines the level of color information saved in the bitmap file. 



Type
The type of bitmap. 
RLE stands for run-length-encoding and results in compressed (smaller) bitmap files.
BMP is for standard bitmap files



Size
The size of the picture to save. 
The current view is as seen in SnapShot client. If the picture is stretched this size will be used.
Original will save the picture at the same size as when the picture was loaded or the capture 
was made.
Full screen saves the picture stretched to the size of the screen.



List Files of Type
Select type of file.



Drives
Select current drive



Automatically Load Film When Starting automatically loads the film when you start 
SnapShot 3. You are ready to start taking pictures!



Automatically Restore After Capture automatically displays the picture you just captured 
in the SnapShot 3 window.



Automatically Stretch Picture In View automatically stretches the picture you are viewing 
to the current size of the SnapShot 3 window.



Automatically Put Picture In The Clipboard automatically copies the picture you just took 
to the Clipboard, as well as displays it in the SnapShot 3 window.



Automatically Hide During Capture automatically hides SnapShot 3 when you take a 
picture. With this option, you can take screen captures which do not contain SnapShot 3.



Automatically Print After Capture automatically have SnapShot 3 print after performing a 
capture. With this option set you now have a Print Screen feature available from your right 
mouse button.



Captures Of Client Only captures only the client area of the window (the area inside the 
window borders and Title Bar). SnapShot 3 will not include the title and border areas.



Warn If Picture Needs Saving informs you when a picture needs to be saved. If you try to 
open another picture, paste in a picture, capture another image or close SnapShot 3 without 
saving the current picture a warning box will prompt you.



Ignore Right Button In Client Areas sets SnapShot 3 to ignore Right Button presses over 
client areas of applications. This is useful if you are trying to capture a portion of an applications 
window that itself uses the Right button. 



Raised Status sets the Status Line to have a raised look.



Warn if converting 24bpp Image sets SnapShot 3 to warn you when you attempt to open a 
24bpp image on a 256 color device. In this case SnapShot 3 needs to reduce the color content 
of the image. The image will not look as good as it would if you viewed with your monitor set for 
more colors. Due to the reduced color content stretching the image may produce a distorted 
image.

You should not save this image or you will lose some of the color. 



 Using OLE (Object Linking and Embedding)

SnapShot 3 supports object linking and embedding. Two applications are necessary for OLE to 
work: One that includes objects in a file, the client (for example a word processor). A second 
that creates and modifies objects is called the server.

SnapShot 3 supports creating and modifying of screen captures and performs the role of a 
server.

In a typical scenerio the user of a word processor desires to insert a screen capture. With OLE 
and SnapShot 3 they only need to select Edit - Insert Object and select SnapShot from the list 
of installed objects. SnapShot 3 will be run. After you have created a screen capture select the 
File - Update menu item. This will pass the new capture back into your word processor. If you 
had selected File - Exit SnapShot 3 would have asked you if it should update your word 
processor before closing. In this scenerio the user has embedded a screen capture. If at any 
time in the future they decided to change or update the screen capture they only need to double
click on the screen capture image in the word processor to get SnapShot 3 running with that 
image loaded. Taking another capture and selecting File - Update causes a new capture to 
replace the old in the word processor's document.

You can also link a saved screen capture into a word processing document. Linking inserts only 
the location and type of object into the document thereby reducing the size of the document. 
You can still edit the document by double clicking on it but the information for the screen capture
is saved in a separate file from the document. To link a screen capture run SnapShot 3 and 
capture an image. Save the image to a file. Select the Edit - Copy menu item to place the 
image on the clipboard. Return to your word processor and select Edit - Paste Link. 

Note:
The above examples used Microsoft Write as an example. Some applications may differ in their 
menu naming convention. Also, you should review to client applications documentation for 
more information about embedding objects and linking objects.

Examples...
Embedding a screen capture
Linking a screen capture
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Embedding a screen capture

It is possible to embed a SnapShot 3 screen capture into a client application such as Microsoft 
Write, Microsoft Word and Microsoft Excel. 

The following is a step-by-step example of embedding a SnapShot 3 screen capture into 
Microsoft Write. When using other client applications the process should be the same.

To embed a screen capture into a client application

1. Start Write. The Write application icon is typically in the Program Manager's Accessories 
Group.

2. From the Edit Menu select Insert Object

3. In the Insert Object dialog box scroll through the Object Type listbox items until you find 
SnapShot 3 Capture. If you do not find it then you might not have run SnapShot 3. When 
SnapShot 3 is run for the first time it notifies your system of it's existance. This is necessary for 
it to be displayed in the Insert Object dialog.

4. After you select SnapShot 3 Object click on the OK button. SnapShot 3 will be launched.

5. SnapShot 3's caption will be SnapShot  3 - (Untitled) in Write.

6. Perform a capture with the right mouse button. 

7. Next you can have the capture embedded in your Write document by selecting the Update 
Write menu item off the File menu in SnapShot 3.

8. Exit SnapShot 3. If you did not manually update Write SnapShot 3 will prompt you select Yes 
if you want the capture embedded into Write.

9. If you ever want to update the capture you have embedded into Write all you need to do is 
double click it and SnapShot 3 will start with the capture loaded. Then you can redo the capture 
if desired and following the above steps Update the embedded capture to the new version.



Linking a screen capture

It is possible to link a SnapShot 3 screen capture into a client application such as Microsoft 
Write and Microsoft Excel. 

The following is a step-by-step example on linking a SnapShot 3 screen capture to a Write 
document. When using other client applications the process should be the same.

To link a screen capture into a client application

1. Start Write. The Write application icon is typically in the Program Manager's Accessories 
Group.

2. Start a copy of SnapShot 3.

3. Perform a screen capture and save it to a file.

4. Select Edit - Copy to place the screen capture in the Clipboard.

5. Return to Write and select Paste Link off of the Edit menu in Write.

6. This will place a link to the screen capture into Write. With a linked object the data for the 
object is stored in a separate file and can be updated separately if desired. You can also update 
a linked object by double-clicking on it. If you double click on a linked screen capture 
SnapShot 3 will be started.



 Contacting Beacon Hill Software

We hope you find this software easy to use and helpful. If you have any questions, comments, 
or suggestions please contact us at:

Beacon Hill Software
Box 8494
Boston, MA 02114

Phone: (800) BHS-1236
or
(627) 926-2956

Fax: 617-926-3805

Internet: info@beaconhill.com

CompuServe ID: 74130,2452
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Version 1.3

SnapShot 3 now supports more graphic file types. 

You can now read the following image types:

BMP Windows bitmaps
GIF CompuServe graphics interchange file format
ICO Windows icons
JPG JPEG (Joint Photographic Experts Group)
PCX Zsoft PCX format
PCD Photo CD files
PCT Apple Pict files
TGA Targa file format
TIF TIFF (Tagged Image File Format) files

You can save to the following formats:

BMP Windows bitmaps
GIF CompuServe graphics interchange file format
JPG JPEG (Joint Photographic Experts Group)
PCX Zsoft PCX format
PCT Apple Pict files
TGA Targa file format
TIF TIFF (Tagged Image File Format) files

See...
Open
Save As...
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SnapShot 3 Eval Version

The evaluation version of SnapShot 3 allows you to evaluate SnapShot 3. It is fully functioning. 
The only limitations over the retail product are:

The evaluation copy runs out on a certain day. When you first run it a message box will remind 
you of this date.

The evaluation copy only supports BMP file types. The full retail product supports much more.

See...
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SnapShot 3 NT/Win95

There are a few characteristics and limitations in using SnapShot 3 NT/Win95 under NT or 
Windows 95.

If you are running Windows NT click here

If you are running Windows 95 click here

See...
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Windows NT

If you are using SnapShot 3 NT/Win95 under Windows NT you should know about the following 
characteristics and limitations.

You cannot capture the desktop or a Command Prompt window with the right mouse button. 
Use the desktop keyboard combination (Ctrl+Alt+D) to capture the desktop. If you are trying to 
capture the Command Prompt window you can then select it by cutting from within SnapShot 
itself.

If you are selecting an area of a window and move the mouse outside of the window the 
selection rectangle may get stuck as you try to move off the window. If you need more than the 
window you are dragging over capture the desktop and do your cutting from within SnapShot.

See...
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Windows 95

There is one characteristic in using SnapShot 3 NT/Win95 under Windows 95. Sometimes when
you click on something to perform a screen capture, a menu will popup when you release the 
right mouse button.

If you wish to avoid this use the desktop keyboard combination (Ctrl+Alt+D) to capture the 
desktop into SnapShot and do your capture of this image.

See...
Introduction

Contacting Beacon Hill Software




